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V40 Arduino Demoboard Components



Power the board

To power the board using screw terminal. Place

the cables on the screw terminals (1) and turn 

the power switch ON (2). Power supply can be 

9-30VDC. The power capacity output is 5V/5A 

and 3,3V/0,7A 

During the Nano programming, switch ON the 

power supply.

Per alimentare la scheda inserire i cavi di 

alimentazione nel morsetto (1) e poi azionare 

l’interruttore (2). La tensione di alimentazione in 

ingresso può variare in un range da 9 a 30Vcc.

All’accensione si accendono i led 5V e 3,3V

Le correnti erogabili sono: 5V/5A  3,3V/0,7A

In fase di programmazione del modulo Nano

la demoboard deve essere alimentata.

Components on Board

Tutti i componenti installati a bordo sono facilmente sostituibili in caso di guasto

All installed components on board , are easily replaceable in case of failure



MCU Arduino Nano

Arduino Nano V3 is a surface mount breadboard embedded

version with integrated USB. It is a smallest, complete, and

breadboard friendly. It has everything that Arduino UNO has

(electrically) with 8 analog input pins,14 digital I/O pin, and

onboard +5V AREF jumper. This 3.0 version comes with

ATMEGA328 which offer more programming and data

memory space. The Arduino Nano is powered via 5V

regulated external power supply (pin 27). During the NANO

programming, switch ON the power supply of demoboard

L’Arduino Nano V3 è una scheda basata sul microcontrollore

ATmega328. E’ dotata di 14 pin di input/output digitali (6 dei

quali possono essere usati come segnali PWM), 8 input

analogici, un quarzo a 16MHz, un connettore Mini-B USB, un

connettore per la programmazione ICSP ed un pulsante di

reset. Si installa sull’apposito zoccolo della V40, facendo

attenzione al verso d’inserzione, e si programma

collegandola, via USB, al PC tramite un cavo mini-USB. E’

alimentata a 5V attraverso il pin 27. In fase di

programmazione del modulo Nano, l’alimentatore di bordo

deve essere mantenuto acceso.

Electrical pin out

Prima di inserire il modulo Nano nel supporto 

assicurarsi che l’alimentazione sia spenta. 

L’orientamento del modulo corrisponde al 

profilo della serigrafia sulla V40. I pin D12 e 

D13 del Nano corrispondono ai pin B4 e B5

della serigrafia.  Inserire lentamente il modulo 

nel supporto e controllare con attenzione le 

connessioni. Soltanto dopo i controlli, 

alimentare la scheda.

Before you plug the microcontroller card into 

the socket, make sure that the power supply 

is turned off. Image show how to correctly 

plug the card. First make sure that Nano card 

orientation matches the silkscreen outline on 

the demoboard V40. The D12 and D13 pin of 

the Nano card correspond to the B4 and B5

pin of the silkscreen . Then put the Nano card 

slowly down until all the pins match the 

socket. Check again if everything is placed 

correctly. Only now you can turn on the 

power supply.



On-board programmer

L’arduino Nano può essere impiegato come 

programmatore ISP-AVR. I collegamenti necessari

sono derivati dalle linee digitali del modulo Nano e 

fanno capo allo zoccolo 28 pin, posizionato all’interno 

dell’area layout Arduino Uno. Inserire un chip 

Atmega328P-PU vergine sullo zoccolo. Per installare il 

bootloader nel chip Atmega328P, (1) lanciare l’IDE 

arduino, (2) portarsi sul menù strumenti e scegliere 

Arduino as ISP, (3) dal menù strumenti selezionare la 

voce Scrivi bootloader per avviare la scrittura del chip. 

Se la programmazione ha successo, il chip è pronto per 

ricevere nuovi sketch o per essere programmato 

secondo necessità. Per comprendere meglio l’impiego 

di Arduino come ISP è bene visitare il sito ufficiale 

Arduino e leggere il tutorial 

Using an Arduino as an AVR ISP

The Arduino Nano can be used as ISP-AVR

programmer. The necessary connections are derived

from the digital lines of the Nano module and are

connected to the 28 pin socket, located within the

Arduino Uno layout area.

Insert the Atmega328P-PU chip to be programmed,

paying attention to the right direction. In order to start

using the ISP-AVR programmer, you just have to follow

three simple steps: (1) connected the Nano module to

the USB port of PC, (2) Launch the arduino IDE and go

to the Tools menu: choose Arduino as ISP. (3) From the

Tools menu, select the Write bootloader for to start the

chip programming. If programming is successful, the

chip is ready to receive sketches. To better understand

the use of Arduino as an ISP-AVR programmer, is good

to visit the official Arduino website and read the tutorial

Using an Arduino as an  AVR ISP

https://www.arduino.cc/en/Tutorial/ArduinoISP
https://www.arduino.cc/en/Tutorial/ArduinoISP


Programming software - Getting Started

L'ambiente di sviluppo integrato (IDE) di Arduino è un'applicazione multipiattaforma in Java, ed è derivata dall'IDE

creato per il linguaggio di programmazione Processing e per il progetto Wiring. È stata creata da Massimo Banzi,

David Cuartielles, Tom Igoe, Gianluca Martino, e David Mellis, per iniziare alla programmazione i neofiti, che siano a

digiuno di pratica nello sviluppo di software. Per permettere la stesura del codice sorgente, l'IDE include un editore di

testo dotato inoltre di alcune particolarità, come il syntax highlighting, il controllo delle parentesi e l'indentazione

automatica. L'editor è inoltre in grado di compilare e caricare sulla scheda Arduino il programma eseguibile in una

sola passata e con un solo click. In genere non vi è bisogno di creare dei Makefile o far girare programmi dalla riga di

comando. L'ambiente di sviluppo integrato di Arduino è fornito di una libreria software C/C++, chiamata "Wiring"

(dall'omonimo progetto Wiring): la disponibilità della libreria rende molto più semplice implementare via software le

comuni operazioni di input/output.
(Da Wikipedia enciclopedia libera)

Per installare l’IDE di Arduino sul vostro PC, portarsi al sito www.arduino.org ed eseguire il download del software.

Il sistema operativo necessita dei driver adatti per permettere all’IDE di Arduino di comunicare con il modulo 

Nano. Windows, riconosce automaticamente il nuovo hardware appena collegato al PC: collegando il modulo 

Nano al pc tramite il cavo USB, attendere che la procedura guidata per l’installazione del nuovo hardware esegua 

il proprio ciclo.  Per i moduli Nano che installano l’interfaccia USB-Seriale CH340, il driver deve essere installato 

manualmente. Vediamo insieme quali sono i primi passi necessari per avviare l’IDE Arduino:

(1) Scaricare il software da arduino.org/download

Per gli utenti Windows consigliamo di utilizzare il pacchetto Zip che installa direttamente tutto il necessario per 

utilizzare il software Arduino (IDE),driver compresi. 

(2) Installare il software e i driver. (Windows)

Scaricato il pacchetto Zip dell'IDE, estrarre il file. Conservare i file estratti in una cartella nominata, ad esempio,

Arduino Files. Eseguire l’installazione del software. Verificandosi problemi di installazione dei driver, procedere 

con l’installazione manuale degli stessi, facendo riferimento alla cartella «driver», rintracciabile in Arduino Files).

(3) A installazione completata, lanciare l’IDE Arduino e aprire un esempio.
Aprire il programma di esempio Blink, portandosi su File> Esempi> 1.Basics> Blink

(4) Selezionare il modello di scheda su cui si opera:  Strumenti> Scheda Arduino Nano

(5) Selezionare la porta seriale di comunicazione: Strumenti> Porta> Com? (?= porta seriale indicata in strumenti)

(6) Caricare il programma. Fare click sul pulsante Carica. Dopo pochi secondi si notano i LED RX-TX del modulo 

Nano lampeggiare. Se il caricamente è andato a buon fine sarà visualizzato il messaggio Caricamento 

completato. Immediatamente dopo si noterà il led del pin 13 sulla scheda lampeggiare.

http://www.arduino.org/downloads
http://www.arduino.org/downloads


Getting Started

(1) Download and install the Arduino Software IDE - Integrated Development Environment

Before you start controlling the world around you, you’ll need to download the IDE to program your board.

The Arduino IDE allows you to write programs and upload them to your Arduino.

Downlaod the latest version of the IDE from: arduino.org/download

For Windows users: You can choose between the Installer (.exe) or the (.zip) Zip package. We suggest you 

use the first one that installs directly everything you need to use the Arduino Software (IDE), including the 

necessary drivers for your board to be detected by your PC. With the Zip package you need to install the 

drivers manually.

(2) Connect the board and install drivers. Have your Arduino board and USB cable near your computer

Windows: If you downloaded the Zip package of the IDE, unzip the downloaded file. Make sure to preserve 

the folder structure. Now your drivers will be downloaded and installed from Internet, directly from 

Windows. If you have issues with the drivers automatic detect and install, you can find a local copy in the 

"drivers" folder inside the unzipped file structure. Follow this guide: Manual installation of drivers on 

Windows to get the drivers installed.

Now that you’ve installed the Arduino IDE and your computer can talk to the board, it’s time to make sure 

you can upload a program. 

(3) Open an example

Open the LED blink example program (sketch): File > Examples > 1.Basics > Blink

(4) Select your board

Select the entry in the Tools > Board menu that corresponds to your Arduino board (Arduino Nano).

(5) Select your serial port

Select the serial device corresponding to your Arduino board from the "Tools | Serial Port" menu.

(6) Upload the program 

Now, simply click the "Upload" button on the IDE. Wait a few seconds, you should see the RX and TX LEDs 

on the board flashing. If the upload is successful, the message "Done uploading" will appear in the status 

bar on the IDE. A few seconds after the upload finishes, you should see the pin 13 (L) LED on the board 

starts to blink (in orange). If it does, congratulations! You've gotten Arduino up-and-running, try to change 

the number in the delay() commands on the editor and upload again, see the difference?

(7) Enjoy!

Examine the built-in and libraries examples, ask questions. If you are looking for inspiration you can find a 

great variety of Tutorials and Examples and a community to support you.

http://www.arduino.org/downloads
http://www.arduino.org/learning/getting-started/manual-installation-of-drivers-on-windows


Input – Output module

I terminali digitali dell’Arduino, facenti capo ai Port B, D, 

possono essere configurati via software come ingressi o 

uscite. Le linee digitali configurate come input, sono poste in 

uno stato di alta impedenza. Dal punto di vista hardware 

attraverso la configurazione circuitale adottata, i pin hanno un 

riferimento al potenziale di massa, per evitare cambiamenti 

casuali dello stato logico in caso di disturbi elettrici.

Se configurate come Output, le linee sono poste in uno stato 

di “bassa impedenza” e possono erogare correnti fino a 40mA. 

Non possono alimentare direttamente relè o motori, ma 

possono agevolmente alimentare led o sensori che richiedono 

pochi milliampere per il loro funzionamento. Il cortocircuito 

sui pin d’uscita del microcontrollore comporta la distruzione 

dei circuiti interni al chip. Per questo motivo ogni linea 

digitale, nel circuito di bordo, è dotata di resistenza limitatrice, 

collegata in serie al pin. Da notare, che i terminali elettrici 

liberi, posti ai bordi della scheda, relativi ai Port A, B, D, sono 

direttamente collegati ai pin del microcontrollore e non 

usufruiscono di alcuna protezione hardware. Se impiegati, si 

raccomanda la massima attenzione nei collegamenti, 

adottando  opportune resistenze di protezione.



The digital lines of  PortB and PortD, can be 

configured, via software, as inputs or outputs. 

From the hardware point of view, through the 

adopted circuit configuration, the pins have a 

reference to the ground potential to avoid 

random changes of the logic state in case of 

electrical disturbances.  If configured as Output, 

the lines are placed in a "low impedance" state 

and can deliver currents up to 40mA. They 

cannot directly power relays or motors, but they 

can easily power up LEDs or sensors that require 

a few milliamperes for their operation. The short 

circuit on the output pins of the microcontroller 

results  the destruction of the internal circuits of 

the chip. For this reason, each digital line in the 

circuit board is equipped with a limiting resistor, 

connected in series to the pins. It should be 

noted that the free electrical terminals located at 

the edges of the card relative to Ports  B, C, D,  

are directly connected to the microcontroller 

pins and do not use any hardware protection. 

Pay close attention to external connections, 

always using protection resistors. It should be 

noted that the free electrical terminals located at 

the edges of the card, relative to Ports  B, C, D,  

are directly connected to the microcontroller 

pins and do not use any hardware protection. 

Pay close attention to external connections,  

using always protection resistors.

MCU Decription Port functions Comment

D2 INT/DIGITAL PortD

D3 PWM/INT/DIGITAL PortD

D4 SDA/DIGITAL PortD

D5 PWM/SCL/DIGITAL PortD

D6 PWM/DIGITAL PortD

D7 DIGITAL PortD

D8 DIGITAL PortB

D9 PWM/DIGITAL PortB

D10 PWM/SS/DIGITAL PortB

D11 PWM/MOSI/DIGITAL PortB

D12 MISO/DIGITAL PortB

D13 SCK/DIGITAL (LD13) PortB

By operating the digital module buttons, it changes 

the logic state of the digital lines according to the 

preset on the SW1 switch. You get a digital 

command, with transaction from logical zero to 

high, if SW1 is placed on Vcc, from  logic high to 

zero, if SW1 is positioned to ground.

The pin pull-up can be set via hardware by 

connecting to the digital lines an appropriate value 

resistance (10KΩ included in the kit) or, by 

software, by setting the "pinMode (pin, INPUT) and 

DigitalWrite (pin, HIGH)" setting,  that activates a 

internal Input  resistance of about 20-50KΩ.

The LED diode signals the logic state of the line.



Output module ULN2003

Le uscite digitali di un microcontroller Atmega328

possono supportare, in generale, correnti di circa

40mA a 5V. Per evitare danni permanenti al

microcontrollore, è prudente considerare i valori

operativi massimi del chip. In caso di

funzionamento stazionario, non transitorio delle

uscite digitali, si consiglia di non superare le

correnti di Sink e Source indicate nel datasheet. In

particolare, la somma di tutte le correnti IOH

(Source) e IOL (Sink) circolanti nei pin

dell’Atmega328, non deve superare il valore totale

IOH di 150mA e totale IOL di 100mA.

Molte informazioni a tal riguardo sono reperibili

sul sito del costruttore Atmel. Quando si ha la

necessità di comandare carichi superiori, sia in

corrente che in tensione, come lampade, led,

motori, ecc., è raccomandato l’impiego di buffer

amplificatori. L’integrato ULN2003 è un array di

sette transistor Darlington con emettitori in

comune e può sopportare correnti d’uscita fino a

500mA. Ogni canale contiene le resistenze

necessarie per la limitazione della corrente di base

dei transistor Darlington e diodi di protezione,

collegati a catodo comune, per proteggere i

transistor dalle sovratensioni generate dai carichi

induttivi durante la commutazione.

A bordo scheda, l’ULN2003 è connesso al

microcontrollore attraverso un dipswitch che

permette l’inserimento delle linee Digitali oppure

PWM al carico d’uscita. Una linea dell’ULN2003 si

collega all’interfaccia ESP8266 quando è usata in

versione NodeMCU.

MCU Description Comment

D3 PWM/INT/DIGITAL PortD

D5 PWM/SCL/DIGITAL PortD

D6 PWM/DIGITAL PortD

D9 PWM/DIGITAL PortB

D10 PWM/SS/DIGITAL PortB

D11 PWM/MOSI/DIGITAL PortB

GPIO-2 ESP8266 NodeMCU

The digital outputs of an Atmega328

microcontroller can, generally, support currents

of about 40mA to 5V. To avoid permanent

damage to the microcontroller, it is prudent to

consider the maximum operating values

recommended by the manufacturer. In the case

of stationary, non-transient digital output, it is

advisable not to exceed the Sink and Source

currents indicated in the datasheet. Specifically,

the sum of all the current IOH (Source) and IOL

(Sink) flows circulating in the Atmega328 pins,

must not exceed the total IOH value of 150mA

and the total IOL of 100mA. Many technical

informations on this argument is available on the

Atmel manufacturer site. When you need to

control higher loads, both in current and voltage,

such as lamps, LEDs, motors, etc., the use of

amplifier buffers is recommended. The ULN2003

chip, is an array of seven Darlington transistors

with common emitters and can withstand output

currents up to 500mA. Each channel contains the

resistors necessary for limiting Darlington's base

current current and common-cathode diodes, to

protect transistors from overvoltages generated

by inductive loads during switching. On board ,

the ULN2003 is connected to the microcontroller

through a dipswitch that allows the insertion of

digital lines or PWM signals to the output load.

One line of ULN2003, is connected to the

ESP8266 interface when it is used in the

NodeMCU version

http://www.atmel.com/images/Atmel-8271-8-bit-AVR-Microcontroller-ATmega48A-48PA-88A-88PA-168A-168PA-328-328P_datasheet_Complete.pdf
http://www.atmel.com/images/Atmel-8271-8-bit-AVR-Microcontroller-ATmega48A-48PA-88A-88PA-168A-168PA-328-328P_datasheet_Complete.pdf


Digital I/O expander I2C with PCF8574 

Sono numerose le applicazioni in cui è 

necessario controllare linee digitali, oltre quelle 

disponibili nel microcontrollore. Non sempre è 

possibile impiegare microcontrollori più potenti, 

come ad esempio l’ATmega2560, e non sempre 

questa soluzione è praticabile per ragioni di 

costi, riduzione spazio pcb e modularità. La 

soluzione in questi casi, può essere offerta 

impiegando alcuni chip, definiti I/O expander, 

che attraverso la comunicazione dati seriale I2C 

permettono di “espandere” il numero di linee 

digitali, aggiungendo risorse hardware al 

circuito. La scheda impiega il PCF8574 come I/O 

expander gestibile attraverso le linee dati SDA e 

SCL e i terminali d’indirizzo A0, A1, A2. 

L’integrato è alimentato con una tensione di 5V, 

prelevata dalla linea di alimentazione generale 

della scheda.  Alcune configurazioni possibili 

sono illustrate qui di seguito:

There are numerous applications that need to 

control digital lines, beyond those available in 

the microcontroller. It is not always possible to 

use more powerful microcontrollers, such as 

ATmega2560, and this solution is not always 

feasible for cost reasons, PCB space reduction, 

and modularity. The solution in these cases can 

be offered by using some chips, called I / O 

expander, which through the I2C serial data 

communication allow to "expand" the number 

of digital lines by adding hardware resources to 

the circuit. The board employs the PCF8574 as 

an I / O expander managed through SDA and 

SCL data lines and address terminals A0, A1, A2. 

The chip is powered by a 5V voltage, taken from 

the general power supply line of the board. 

Some possible configurations are illustrated 

below:

8 uscite led   8 output led

4 uscite led 4 ingressi digitali      4 output led  4 digital inputs



8 uscite relè     8 relays output

I/O PCF8574 Description

PC5/SCL (14) Linea clock

PC4/SDA (15) Linea Dati

A0 (1) Indirizzo A0

A1 (2) Indirizzo A1

A2 (3) Indirizzo A2

INT Non connesso

P0 Port bidirezionale P0

P1 Port bidirezionale P1

P2 Port bidirezionale P2

P3 Port bidirezionale P3

P4 Port bidirezionale P4

P5 Port bidirezionale P5

P6 Port bidirezionale P6

P7 Port bidirezionale P7



LCD Module Control Using PCF8574

Una volta presa famigliarità con led ed interruttori, 

il passaggio successivo è l’approdo all’impiego di 

un display LCD. Sulla demoboard si possono usare 

moduli LCD che dispongono di un’interfaccia 

compatibile con il set d’istruzione HD44780, ad 

esempio, un modulo 16x2. L’utilizzo di display LCD 

con Arduino richiede numerose linee di I/O del 

microcontrollore, impegnando molte risorse dello 

stesso. Per ridurre il numero di linee, lasciando 

risorse al micro, può essere vantaggioso utilizzare 

l’interfaccia seriale/parallela PCF8574, che utilizza il 

bus I2C e necessita solo di due fili di collegamento 

SDA-SCL, a parte i collegamenti di alimentazione.  

Perché il display funzioni, si devono portare a ON 

le linee collegate al dip-switch LCD-SW. La 

retroilluminazione è di tipo ON-OFF e si attiva 

portando in saturazione il transistor BC547, 

collegato al catodo del diodo led. Il contrasto è 

regolato dal potenziometro RV5.

Once you are familiar with LEDs and switches  the 

next natural step is 16×2 alphanumeric LCD 

modules. On demoboard  , You can use  LCD 

modules that have a HD44780-compatible 

interface with various screen sizes. For example a 

16 x 2 module. Using LCD display with Arduino 

needs many I/O lines of  microcontroller (parallel 

interface). To reduce the number of lines, by 

releasing resources to the microcontroller, it may 

be advantageous to use the parallel/serial 

interface PCF8574. This interface uses  the I2C 

bus and need only two wires SDA - SCL apart 

from the power connections. The lines connected 

to the LCD-SW, must be switched to ON. The 

backlight  is activated by  the transistor BC547, 

and the contrast is adjusted using the RV5 

potentiometer.



Serial Led Display  with MAX7219 controller

L’integrato MAX7219 è stato progettato da 

Maxim Integrated per controllare in via seriale 

sincrona display digitali a segmenti LED o matrice 

di punti. Il componente permette di pilotare 8 

display a segmenti led,  catodo comune, oppure 

64 led singoli, organizzabili in vario modo per 

realizzare matrici led 8x8, bargraph o 

configurazioni personalizzate. Nella struttura 

interna, il MAX7219 dispone di una memoria 

statica 8x8 in grado di conservare i dati di ogni 

digit, una codifica BCD code-B e una serie di 16 

registri, ognuno con una funzione specifica. 

L’intensità luminosa dei led si ottiene in due modi: 

via hardware attraverso una resistenza esterna di 

≥9,53KOhm, collegata al pin Iset, che limita la 

corrente massima di assorbimento dei led a 

massimo 40mA. Oppure, via digitale, utilizzando 

l’intensity register, si ottiene il “PWM dimming” 

impostabile su 16 livelli diversi, a una frequenza di 

circa 800Hz. La scheda V40 è dotata di un 

connettore specializzato sul quale si innesta un 

display MAX7219 a segmenti led, 8 digit. È 

possibile derivare dallo stesso connettore i 

collegamenti per pilotare display led a matrice di 

punti. Prima d inserire il display al connettore 

controllare attentamente il verso d’inserzione.

The  MAX7219 chip is designed by Maxim 

Integrated to synchronously monitor LED 

segment or point matrix digital displays. The 

component allows you to drive 8 LED displays, 

common cathode, or 64 individual LEDs that 

can be organized in various ways to create 8x8 

led, bargraph or custom led configurations. In 

the internal structure, the MAX7219 has 8x8 

static memory that can store data of each digit, 

a BCD code-B encoding, and a set of 16 

registers, each with a specific function. 

The luminous intensity of the LEDs is obtained 

in two ways: via hardware by an external 

resistor of ≥9.53KOhm, connected to the Iset 

pin, which limits the maximum absorption of 

LEDs up to 40mA,  or digitally, using the 

intensity register, you get the "PWM dimming" 

that can be set on 16 different levels, at a 

frequency of about 800Hz. The V40 card is 

equipped with two  connector where is 

possible connect  one MAX7219 interface 

complete of 8 digit LED display. Before insert 

the display card in to the header, check right 

direction.



The Analog Inputs

The Atmega328 controller used for the Arduino 

Nano contain an onboard 6 channel analog-to-

digital (A/D) converter. The converter has 10 bit 

resolution, returning integers from 0 to 1023. 

While the main function of the analog pins for 

most Arduino users is to read analog sensors, 

the analog pins also have all the functionality of 

general purpose input/output (GPIO) pins (the 

same as digital pins 0 - 13). Consequently, if a 

user needs more general purpose input output 

pins, and all the analog pins are not in use, the 

analog pins may be used for GPIO. The analog 

pins can be used identically to the digital pins, 

using the aliases A0 (for analog input 0), A1, etc.

The analog pins also have pullup resistors, which 

work identically to pullup resistors on the digital 

pins. The analog inputs, coming from the JTPC 

header,  are directly connected to the 

microcontroller without any signal conditioning. 

It will be the user's concern to apply the circuitry 

needed to correctly processing of  the signals. 

The "Analog Inputs" module allows:

• the simulation of analog signals by means of 

four potentiometer;

• the connection of analog sensors such 

NTC/PTC, LM35, Photoresistors, etc;

• the connection  of digital sensors such 

DS18B20, DHT11, etc.

The minimum voltage that the ADC can 

discriminate is 1024/5  4.88mV . All the analog 

lines are  selectable through an 8-pole dip-

switch. Pull-up resistors are provided on the 

outputs of the digital sensors.

The Atmega328 controller usato nel modulo 

Arduino Nano contiene 8 canali A/D. Il 

convertitore AD ha una risoluzione di 10bit e 

restituisce un valore intero compreso tra zero e 

1023. I pin AD, usati generalmente  per la lettura di 

segnali analogici, dispongono di tutte le 

funzionalità dei pin digitali, pertanto possono 

essere usati anche come GPIO nel caso non siano 

usati come AD. Sono anch’essi dotati di resistori di 

pull-up che funzionano allo stesso modo dei pin 

digitali. Le linee analogiche, provenienti dal 

connettore JTPC, sono collegati direttamente al 

microcontroller senza alcun trattamento del 

segnale (condizionamento). Sarà cura 

dell’utilizzatore applicare gli accorgimenti circuitali 

necessari alla corretta acquisizione dei segnali. Il 

modulo “Ingressi Analogici” consente:

• la simulazione di segnali analogici a mezzo di 

quattro potenziometri;

• la connessione di sensori di temperatura quali 

NTC-PTC, LM35, ecc;

• la connessione di sensori digitali DS18B20, 

DHT11, ecc.

La minima tensione che l’ADC riesce a discriminare 

è di  (5/1024)  4,88mV.  Le linee sono tutte 

sezionabili attraverso un dip-switch a 8 poli. Sono 

previste resistenze di pull-up sulle uscite dei 

sensori digitali. 



MCU Description Comment

PC0-A0
C0-ADC0 - Potentiometer
simulazione A0

PortC  

PC1-A1 C1-ADC1 - Potentiometer

simulazione A1
PortC

PC2-A2 C2-ADC2 - Potentiometer

simulazione A2
PortC

PC3-A3 C3-ADC3 - Potentiometro

simulazione A3
PortC

PC4-A4 C4-ADC4-SDA (jumper pull-up) PortC  

PC5-A5 C5-ADC5-SCL (jumper pull-up) PortC

PC6-A6 ADC6 - NTC-PTC PortC

PC7-A7 ADC7 - LM35) PortC

PD7-D7 DS18B20 PortD

GPIO-2 DS18B20 ESP8266

PD2-D2 DHT11 PortD

I terminali di input AD devono ricevere una tensione con polarità positiva. L’inversione di 

polarità causa la distruzione del relativo pin AD o del microcontrollore. Inoltre non collegare ai 

terminali AD tensioni superiori a +5V o inferiori a zero volt (tensioni con polarità negativa).

The AD input terminals need receive a voltage with a positive polarity. Reverse polarity causes 

the destruction of AD or microcontroller pin. Also, do not connect to AD terminals to higher 

than + 5V or less than zero volts (voltages with negative polarity).

Analog module



Wi-Fi and Bluetooth

Per tutte le applicazioni in cui serva instaurare

una connessione di tipo Bluetooth o Wi-Fi, la

scheda V40 è dotata di connettori specializzati

sui quali si innestano la scheda Bluetooth

HC05(06) e Wi-Fi ESP8266. Sul connettore

della scheda Bluetooth è possibile il

collegamento di un adattatore USB-Seriale

PL2303 molto utile, ad esempio, per la

programmazione del modulo ESP8266 in

versione Node Mcu. Il modulo Bluetooth è un

modulo che permette di trasformare una porta

USART, comunemente conosciuta come porta

seriale, in una porta con profilo SPP, Serial Port

Profile. La connessione wireless, Wi-Fi ESP8266,

assicura il trasferimento dati, su aree locali

impiegando piccoli ricetrasmettitori operanti alla

frequenza di 2,4 GHz (gigahertz). Nel campo

delle telecomunicazioni, la tecnologia Wi-Fi

consente a due terminali di collegarsi tra loro

attraverso una rete locale. Grazie a un piccolo

accorgimento circuitale sia la scheda Bluetooth

che quella Wi-Fi, possono restare collegate al

circuito durante la fase di programmazione

dell’Arduino Nano, senza che queste creino

conflitti hardware dei segnali seriali. Azionando

il commutatore ISP-SW in posizione Off, la linea

seriale collegata ai moduli si pone in condizione

di alta impedenza. I segnali RX-TX non potranno

raggiungere i terminali di comunicazione,

evitando l’interferenza con il protocollo di

programmazione Arduino.

For all the applications where need a Bluetooth

or Wi-Fi connection, the V40 card install two

separate port on which is possible connected

the Bluetooth HC05(06) and Wi-Fi ESP8266

modules . On the Bluetooth port, it is allowed to

connect a USB-serial adapter PL2303 too, used

for example for programming the ESP8266 in

the NodeMcu version. The Bluetooth module

transforms an USART port, commonly known as

a serial port, into a Serial Port Profile (SPP port).

SPP is great for sending bursts of data between

two devices. The Wi-Fi ESP8266 wireless

connection ensures data transfer on local areas

using small 2.4 GHz (gigahertz) frequency

transceivers. In the field of telecommunications,

Wi-Fi technology allows two terminals to

connect to each other through a local network.

Thanks to an small electronic switch, both the

Bluetooth and Wi-Fi modules, they can remain

connected to the serial circuit during the Nano

module programming phase, without causing

hardware conflicts of the serial signals. By

switching the ISP-SW to Off, the serial line is

switched to high-impedance. The RX-TX signals

will not reach the communication terminals of

the Bluetooth and ESP8266 modules, avoiding

the interference with the Arduino programming

protocol.



Bootloader ESP8266

Alimentando un modulo ESP8266 V1, questi si potrà avviare con le seguenti modalità :

• UART - Bootloading

• FLASH - Usage

La modalità, SDIO, non è applicabile al modulo ESP8266-V1 a cui facciamo riferimento. 

Il primo utilizzo dell’ESP è come semplice modem di comunicazione Wi-Fi (Modalità Usage). Si collega alla porta 

seriale della demoboard ed è gestito per mezzo di comandi AT. Ciò è possibile grazie al firmware di serie, 

residente nell’ESP8266.

Il secondo utilizzo usa l’ESP come controllore autonomo abilitato al Wi-Fi, programmabile in modo interattivo 

mediante linguaggio di scripting (linguaggio di programmazione interpretato). Nella versione modificata di 

Arduino IDE, la programmazione del modulo ESP avviene grazie un’estensione del linguaggio Wire. In pratica è 

possibile programmare il microcontrollore interno all’ESP come se fosse una scheda Arduino. Il modulo, 

programmato come NodeMcu, può svolgere due funzioni. La prima consente di collegare un sensore 

termometrico tipo DS18B20 (o altro sensore) al pin GPIO2. La seconda permette di attivare un relè, sempre 

attraverso il GPIO2, per mezzo del buffer ULN2003. Lo schema elettrico della pagina precedente, indica quali sono 

i ponti che dovranno essere posizionati per questi impieghi.

La programmazione del modulo ESP8266 in modalità stand-alone, operando in ambiente IDE Arduino,

avviene installando il firmware opensource NodeMcu, per mezzo dell’applicazione ESP8266 Flasher, reperibili 

all’indirizzo web: https://github.com/nodemcu/nodemcu-flasher. 

Per migliori informazioni sull’utilizzo del modulo ESP8266, si prega di consultare il sito nodemcu.com

Modalità GPIO-0 GPIO-1 GPIO-15

Bootloading L H L

Usage H H L

Prima di inserire i moduli nel connettore verificare il senso d’inserzione

https://github.com/nodemcu/nodemcu-flasher
http://nodemcu.com/index_en.html


Bootloader ESP8266

When the ESP8266 V1 module is powered, it may  be initiated  with the following modes:

• UART - Bootloading

• FLASH - Usage

The first use of the ESP module is like a simple Wi-Fi communication modem (Usage Mode). It connects to the 

serial port Wi-Fi of the demoboard and is controlled by  AT commands from Arduino microcontroller. This is 

possible thanks to the standard firmware, resident in ESP8266.

The second use, employs the ESP module as a stand-alone Wi-Fi enabled controller, which can be programmed 

interactively with scripting language (interpreted language). In the modified version of Arduino IDE, programming 

of the ESP module takes place thanks to an extension of the Wire language. In practice, you can program the 

internal microcontroller to the ESP as if it were an Arduino card. The module, programmed as NodeMcu, can 

perform two functions. The first one connects a DS18B20 (or other sensor) thermometer sensor to the GPIO2 pin. 

The second one enables a relay, always through GPIO2, through the ULN2003 buffer. The electrical diagram of the 

previous page indicates which bridges are to be positioned for these uses.

The ESP8266 programming, in stand-alone mode, using the Arduino IDE, 

Is possible  by installing the opensource NodeMcu firmware, using the ESP8266 Flasher application, which can be 

found at https://github.com/nodemcu/nodemcu-flasher. For more information on using the ESP8266, please visit 

the web nodemcu.com

Modes GPIO-0 GPIO-1 GPIO-15

Bootloading L H L

Usage H H L

Before insert the modules in to the header, check right direction.

https://github.com/nodemcu/nodemcu-flasher
http://nodemcu.com/index_en.html


IR Interface

La comunicazione IR o infrarossa è una tecnologia 

di comunicazione wireless poco costosa e facile da 

usare. La luce IR è molto simile alla luce visibile, 

salvo che ha una lunghezza d’onda più lunga, non 

percettibile all’occhio umano. E’ ampiamente 

usata in svariati campi di utilizzo, il più comune di 

questi è il classico telecomando televisivo o il 

telecomando dell’impianto di condizionamento. 

Per emettere radiazioni IR si usano appositi diodi 

led. Sono prodotti di varia qualità e le potenze di 

radiazione , nelle applicazioni industriali, possono 

superare diverse centinaia di watt. Quando si 

utilizza il telecomando TV viene utilizzato un 

diodo led IR per trasmettere informazioni al 

televisore. Modulando il segnale emesso ad una 

frequenza di circa 38KHz, il sensore ricevitore 

provvederà ad amplificare il segnale ricevuto che 

sarà poi decodificato dai circuiti ad esso collegato. 

Il segnale sarà trasformato in un comando per la 

regolazione del volume, ad esempio, piuttosto che 

per il cambiamento di canale o di luminosità.

Il modulo Nano può essere collegato sia per 

modulare i segnali del led emettitore IR che per 

demodulare i segnali provenienti dal sensore 

ricevitore che di solito è un chip di tipo TSOP1838 

o similare. Selezionare il ponte JMPB4 per 

collegare il ricevitore TSOP al modulo Nano, pin 

PB4. Selezionare il ponte JMPB3 per alimentare il 

led IR. Nel kit V40 è compresa la tastiera IR e il 

modulo ricevitore.

IR, or infrared, communication is a common,

inexpensive, and easy to use wireless

communication technology. IR light is very similar

to visible light, except that it has a slightlty longer

wavelength. This means IR is undetectable to the

human eye - perfect for wireless communication. It

is widely used in various fields of use, the most

common of these being the classic remote control

TV or remote control of the conditioning system.

LEDs are used to emit IR radiation. They are

produced in varying quality and the radiation

powers, in the industrial applications, can exceed

several hundred watts. When using the TV remote

control,for example, an IR led diode is used to

transmit information to the TV. By modulating the

output signal, using the remote control, at a

frequency of about 38KHz, the receiver sensor will

amplify the received signal which will then be

decoded by the circuits connected to it. The signal

will be transformed into a volume control

command, for example, rather than for channel or

brightness change. The Nano module can be

connected either to modulate the IR emitter

signals, or to demodulate signals from the receiver

sensor, which is usually a TSOP1838 or similar chip.

Select the jumper JMPB4 for connect the receiver

TSOP to the Nano module(pin PB4), the jumper

JMPB3 (pin PB3) for connect the IR LED. The V40

kit includes keyboard and IR receiver.



The Arduino UNO Layout

La demoboard è provvista di un area prototipale, rappresentata da una serie di connettori installati secondo lo 

standard Arduino. I connettori sono collegati in parallelo alle connessioni del modulo Nano e permettono di installare

a bordo qualsiasi modulo shield che rispetti le dimensioni del layout Arduino UNO. Nella stessa area sono posizionati

gli switch che impostano il senso dei collegamenti della line RS232 agli shield (diretto o invertito), lo zoccolo 28 pin 

relative al programmatore ISP, il connettore ICSP, lo switch di selezione alta-bassa impedenza della linea RS232.

Questa configurazione circuitale rende la massima libertà di collegamenti con il circuito Arduino, permettendo la 

migliore sperimentazione possibile, facilitando notevolmente l’apprendimento iniziale. Si consideri inoltre, a 

differenza dell’impiego di comuni startekit, che non c’è alcun spreco economico in termini di acquisto di materiali e 

che l’utilizzatore può impiegare efficacemente quanto fino ad ora in suo possesso.

The prototipal area of  the demoboard, is derived from the original design of the layout of Arduino UNO. The module  

contains four Input/output ports, for connecting external devices and everything you need to  develop circuits, using  

shield cards compatible with the Arduino UNO layout. 

What’s more,  is also situated in the same area  the 28 pin socket for ISP programmer, the switch for serial 

communication sense ( forward or reverse) and the switch for low or high impedence of RS232 line. This circuital 

configuration offer various advantages and  allows to develop and test  many electronics circuit, making it much 

easier the initial learning.

Teminazioni layout Arduino UNO, con indicazione delle principali funzioni.



V40 Demoboard Schematic

PortB-PortD digital I/O port. La configurazione degli I/O digitali è identica per il PortB e il PortD

PortC Ingressi analogici e one-wire sensori di temperatura.    PortC Analog inputs and one-wire temperature sensors headers

I/O expander digitale PCF8574 e display LCD.    Digital I/O expander PCF8574 and LCD display 



Display seriale led 7 segmenti MAX7219.   Seven segment led display card MAX7219

ULN2003 Buffer e PWM Buzzer (PD3)                                                         Buzzer (modulated by PWM signal PD3)

Modulo IR e pull-up I2C.     IR module and Pull-UP I2C     Moduli di comunicazione Wi-Fi e Bluetooth

Programmatore ISP Atmega 328                                  ISP  Programmer ATmega328



Arduino Nano pin-out

Layout Arduino UNO



Power supply

Tutte le connessioni di bordo                                              Wiring headers terminals

Documento tecnico temporaneo, non definitivo.
Temporary technical document. Non-Definitive guide for the V40 Demoboard
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